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MARYLIE is a FORTRAN program maintained and distributed by Dr. Alex Dragt.
MARYLIE is included with the PBO Lab software with the written permission of
Dr. Alex Dragt.  This Section discusses the PBO Lab Commands and the output
options for the MARYLIE Application Module.  The MARYLIE program is
described in the MARYLIE 3.0 User’s Manual, which is included in the PBO Lab
2.0 User Manual Supplement:  MARYLIE Application Module.

The MARYLIE Program:
MARYLIE Copyright 1990, Alex J. Dragt. All rights reserved.

REVISION RECORD:
June 1998, February 1999, April 1999

DISCLAIMER NOTICE:
The MaryLie 3.0 program is provided "as is" without any warranty of any kind. No
warranties, expressed or implied, are made that the program and its procedures are
free of error, or are consistent with any particular standard of merchantability or
fitness for a particular purpose, or that they will meet your requirements for any
particular application. They should not be relied on for solving a problem whose
incorrect solution could result in injury to a person or loss of property. If you use
this program in such a manner, it is at your own risk. The authors and their
agencies disclaim all liability for direct, incidental, or consequential damage resulting
from your use of the program.

MARYLIE is included with the PBO Lab software under a written agreement with
Dr. Alex Dragt.  The MARYLIE program is described in the PBO Lab 2.0 User
Manual Supplement:  MARYLIE Application Module, which is included with the
PBO Lab MARYLIE Module software.
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1. Getting Started

This Section is intended as a quick start introduction for
running the MARYLIE Application Module.  The
remainder of this Supplement describes the PBO Lab
user interface features that are specific to the MARYLIE
Application Module.  Refer to the PBO Lab User Manual
for more general information on the PBO Lab user
interface.  The MARYLIE 3.0 User’s Manual describes
the MARYLIE program.  

Running MARYLIE

When the MARYLIE Application Module is installed in
PBO Lab, a MARYLIE option will be added to the
Application Context pop-up in Document windows.  The
Application Context is used to indicate native inputs and
in some cases access application-specific parameters for
an Application Module.  MARYLIE sub-menus will also
be placed in the Viewand Commandsmenus.  

The Commands pull-down menu in the PBO Lab
Document window contains sub-menus for any installed
Application Modules.  Execution of MARYLIE is
accomplished from the MARYLIE Commands sub-menu
as illustrated in Figure 1.

Figure 1  MARYLIE Commands Sub-Menu.  

Set the Application Context
for MARYLIE in the
Application Context pop-
up, which is located in the
Document window button
bar.

The MARYLIE Commands
sub-menu is used to select
various Command options
for running the MARYLIE
Application Module.
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The Commands sub-menu for the MARYLIE
Application Module is divided into six groups of
commands in Figure 2 below.  The first group contains
the primary execution commands for Calculating a Beam
Line Map and for performing a Single-Pass or Multi-Turn
Ray Trace or Element by Element Ray Trace.  When
using these commands, MARYLIE will be executed
automatically after application-specific (native) input is
generated from the beam line in the Document Model
Space.  

The MARYLIE Application
Module provides several
options for executing the
MARYLIE program.  

Perform Fitting 

Commands for Calculating the Beam Line 
Map, Executing a Single Pass or Multi-Turn 
Raytrace or Element by Element Raytrace

Commands for Separate Generation of Input 
for MARYLIE and  Execution of MARYLIE

Command to Calculate a Map for a Selection 
of Beam Line Elements and create a Map Piece 

Commands for Setting Up and Performing 
Fitting and for Quick Access to Variables and 

Constraints for the Entire Beam Line

Access to MARYLIE Options for Calculation 
Order, Output Result and Other Preferences

Commands for Generating Particle Distributions 
and Distribution Plots.

Figure 2  MARYLIE Application Module - Commands Sub-Menu.  

PBO Lab 2.0 User Manual Supplement:  MARYLIE Module

2



The second group of commands are used generate native
MARYLIE input without automatically executing the
program. The inputs generated by PBO Lab can be
edited directly and then the last command in this group
can be used to execute MARYLIE with the modified
inputs.  These commands are provided for expert users
that are experienced with the format and syntax of the
various MARYLIE input files.

The next group contains one command that is used to
create a Map Piece for a selection of pieces in the beam
line model.  Lie Maps are an integral part of the
MARYLIE program and the Map Piece provides an
intelligent user interface for editing and visualizing map
data.   The Map Piece encapsulates, organizes and
displays map data.  The Map Piece also supports saving
and loading map data using external files.  The Map
Piece Section describes the Map Piece window and the
Make Map Piececommand in the Beam Line Elements
Section.  

Options for generating particle distributions and plotting
initial and final distributions are in the next group
commands.  The Beam Piece Section describes these
commands.

There are a variety of commands in the next group that
are used to set-up and perform fitting.  The first
command in this group is used to execute MARYLIE
and perform the specified fitting procedures.  The next
two commands are for creating and removing Procedure
Loop Sublines.  The last three commands in this group
are used for display and access to the fitting and coupling
variables and the fitting constraints for the entire beam
line model.  Refer to the MARYLIEFitting Section for a
description the fitting commands and the specification of
fitting procedures.

The last group in the MARYLIE Commands menu
contains one command to access MARYLIE options for
calculation order and output result, in addition to output
file options and various other preferences.  These options
are discussed in the MARYLIE OptionsSection.

Input generated from PBO
Lab can be edited prior to
running MARYLIE.

Refer to the
Map Piece Section.

Refer to the
Beam Piece Section.

Refer to the 
Fitting Section.

Refer to the
Options Section.
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This Getting Started Section is only intended as a brief
overview of running the MARYLIE Application Module
in PBO Lab.  The remainder of this Supplement provides
more information on the material presented in the Getting
Started Section, as well as other important subjects on the
use of MARYLIE in PBO Lab.  Refer to the PBO Lab
User Manual for more general information on the PBO
Lab user interface.  All users are encouraged to read the
entire User Manual.  
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2. User Interface

This Section describes the user interface components that
are specific to the MARYLIE Application Module.  Refer
to the Getting Startedand User InterfaceChapters of the
PBO Lab User Manual for more information on the PBO
Lab user interface.  The MARYLIE 3.0 User’s Manual
describes the MARYLIE program and is referenced from
this Supplement.

Beam Line Global Parameters

The Beam Line Global Parameters were introduced in the
Getting Startedand User InterfaceChapters of the PBO
Lab User Manual.  This Section discusses the Global
Parameters that are used by the MARYLIE Application
Module.  

The native Global Parameters for MARYLIE include the
Particle Charge, Particle Mass, Beam Energy and
Frequency.  These parameters are indicated with Green
Dots in the Document window shown in Figure 3 below.
These parameters are also used for a variety of PBO Lab
calculations and displays.

Select MARYLIE 
Application Context

Green Dots Indicate Global 
Parameters used  by MARYLIE 

Scroll Bar Provides Access to Additional 
Global Parameters used  by MARYLIE 

Figure 3  MARYLIE Application Context.
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MARYLIE also uses the last three Global Parameters,
(not shown in Figure 3) which are accessed using the
scroll bar on the right side of the Global Parameters
display.  The Number of Macro-Particles parameter is
used with Beam Piece parameters to specify an initial
particle distribution.  The Number of Tracking Turns
parameter specifies the number of “turns” through the
beam line model.  The Output Distributions parameter is
used to specify on which turns data will be collected for
multiple turns through the model.  

Beam Line Elements

The PBO Lab Pieces implemented for MARYLIE are
listed in Table 1 below.  Native MARYLIE inputs for
these elements are indicated in the Piece windows.  As
with the Global Parameters, Green Dots are found to the
right of Piece parameters that are native inputs. (The
Application Context must be set for MARYLIE in the
Button Bar of the Document window.)

Table 1  PBO Lab Pieces implemented for MARYLIE

Beam Sector Bend Lens Marker

Drift Rectangular
Bend

Rotate Map

Quadrupole Bend Sextupole Operator

Solenoid Edge Octupole Analyze

RF Gap

The Piece window user interface is described in the
Getting Startedand User InterfaceChapters of the PBO
Lab User Manual.  However, the Map, Operator and
Analyze Pieces have application-specific interfaces which
are described separately in this Section.  In addition to
these Pieces, the Beam Piece and the Marker Piece also
have MARYLIE specific features.  The Beam Piece is
described next.  The Marker Piece is described separately
in this Section.
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Beam Piece

The PBO Lab Beam Piece is used to select between four
different particle distribution types for MARYLIE: 6-D
Equivalent Uniform, 4-D Equivalent Uniform (KV),
Gaussian (5-Sigma) and Rectangular.  The distribution
type is selected with the Particle Distribution Typepop-
up at the top of the Beam Piece window.  The Particle
Distribution Type pop-up is shown in Figure 4, with the
default 6-D Equivalent Uniform distribution type selected.  

The MARYLIE initial particle distribution is also defined
by the Twiss parameters in the Beam Piece window.  The
Courant-Snyder (Twiss) parameter set is selected in
Figure 4, illustrating the Green Dots for the MARYLIE
Application Context.  

Generate Particle Distribution

Figure 4 Beam Piece Particle Distribution.
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The Beam Parameters pop-up may be used to select
between the Twiss parameter set of the Semi-Axis beam
parameters.  These are independent sets of persistent
parameter data that can be used to define two different
initial beams or can be defined as two different
representations of the same beam.  When the Twiss beam
parameters are selected, the Compute From Semi-Axis
button will calculate the equivalent Twiss parameters for
the current Semi-Axis parameters.  When the Semi-Axis
parameter set is selected the Compute From Twissbutton
will calculate the equivalent Semi-Axis parameters for the
current Twiss parameters.  The Compute From...button
is in the button bar at the top of the Beam Piece window.

The Generate Distribution button in the Beam Piece
window is used to generate and plot the specified particle
distribution.  The Marylie Input and Emittance files are
generated from the Beam Piece parameters and Globals.
MARYLIE is called to generate the new Distribution file,
but the standard output file is not opened.  Instead a Plot
Specification window is opened.  Figure 5 illustrates the
Plot Specification window and example initial distribution
plot windows.

Existing MARYLIE Input
and Output files are over-
written with the Generate
Distribution button.

Figure 5 Generate and Plot Particle Distributions from the Beam Piece.  
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Several features of the Plot Specification window are
illustrated in Figure 6 below.  Radio buttons at the top of
the window select between 1-D Projection and 2-D
Correlation plots.  

Specify Vertical Component 
for 1-D and 2-D Plots

Specify Horizontal 
Component for 2-D Plots

Specify Bin Size for 
1-D Projection Plots

Select Axis Range for 
Vertical and Horizontal 

Plot Components

If a Plat Specification is 
Selected in the List then 
the Set Button updates 
that entry , otherwise a 
New Plot Specification 

is Added to the List

Generate the 
Specified Plots

Delete a Selected Plot 
Specification from List

Select between 1-D Projection 
and 2-D Correlation Plots

List of Plot Specifications
(Select with Mouse)

 Auto Scale  Axis Range 
Values to Fit Data

Figure 6  Initial Distribution Plot Specification Window.
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The Distribution data generated by MARYLIE is six-
columns of real numbers (x, xP, y, yP, z, zP) that can be
used to produce any combination of 1-D plots projection
and 2-D correlation plots.  The Plot Specification window
illustrated in Figure 6 shows the Projection Axis pop-ups
for selecting Vertical and Horizontal data from the six
column Distribution data.  The Plot Specification window
also includes a check box for auto scaling the graph axes
to fit the data.  Alternatively, the axes may be specified
directly in the input fields provided.  The bin size input
field is used for generating 1-D Projection plots.  The Plot
button is used to generate the specified plots in individual
Plot Windows, as illustrated in Figure 6.  

Any parameters for any Beam Piece in the Document
window (Model Space or Work Space) can be used to
generate and plot an initial distribution.  However, the
Distribution file is overwritten by MARYLIE each time a
new distribution is requested.  (In the case of execution
commands such as Ray Trace, a new Distribution file will
be automatically requested unless this option has been
disabled in the MARYLIE Options window.)  Any plot
specifications that are made from a Beam Piece window
are persistent with that Beam piece.  Another Beam Piece
will have independent plot specifications.  There are also
commands in the MARYLIE Commands menu to
generate and plot initial distributions.  The Generate
Distribution command uses the Beam parameters of the
first Beam Piece found in the beam line model (walking
the model left to right) in order to write the required
input for MARYLIE to generate an initial distribution.
This command does not automatically open the Marylie
Output window or the Plot Specification window.  It
simply generates the input files and calls MARYLIE.  The
Plot Initial Distribution command can be used to open a
Plot Specification window for the Distribution data file.
(This command can be used at any time to specify up to
six plots of the Distribution data file, independent of any
Beam Pieces.)

Any plot specifications that
are made from a Beam
Piece are persistent data
with that Beam piece.
Another Beam Piece will
have an independent set of
plot specifications

Command menu items to
Create Distribution and
Plot Initial Distribution
are similar to generating a
distribution from a Beam
Piece.
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Map Piece

Lie Algebraic Maps are an integral part of the MARYLIE
program and the PBO Lab Map Piece provides an
intelligent user interface for editing and visualizing
MARYLIE map data.  The Map Piece encapsulates,
organizes and displays map data, in addition to saving and
loading map data using external files.  

A Map Piece can be created for a selection of elements in
the beam line model, or a default identity map can be
dragged from the Palette Bar and inserted into the beam
line model.  The data for an existing Map Piece can be
written to an external file  and Map data can be loaded
into a Map piece from a previously generated map data
file.  However, it is not necessary to save Map Pieces in
separate external files.  All of the data for Map Pieces in
the Work Space and Model Space are saved with the
PBO Lab Document.  The Make Map Piece command
in the MARYLIE Commands sub-menu is used to create
a new Map Piece for the current beam line model
selection, as illustrated in Figure 7.  

Make a Selection in the Beam 
Line Model then choose the 
Make Map Piece Command 

Figure 7  Making a Map Piece from a Selection in the Beam Line Model.
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A Map can only be made from pieces in the Model Space
of the Document window.  If the Make Map Piece
command is used without a selection in the beam line
model then there will be an alert and a Map Piece will not
be created.  A selection of Pieces in the beam line may
contain standard Elements, Sublines, Procedure Loops,
other Map Pieces, and Aliases of all these as well.  A
selection may be a single Piece or include the entire beam
line model.  Creating a Map for the entire beam line is the
same as using the Calculate Beam Line Mapcommand,
except that using the Map Piece loads that data into a
Map Piece and the Calculate command writes the map
data to the Marylie Output file.  

When the Make Mapcommand is executed with a valid
selection in the beam line model, then PBO Lab will
generate the required inputs and call MARYLIE to
generate a map data file.  Following the execution of
MARYLIE the Marylie Output file is not automatically
opened, instead the map data file is automatically loaded
into a new Map Piece which is created on the Work
Space of the Document window.  It can be placed in the
beam line by dragging it with the mouse and inserting it
into the model at the desired location. The original
selection of pieces used to create the Map are not
changed in the beam line.  The new Map could be used to
replace those pieces, resulting in more efficient tracking
calculations.  However, pieces used to create a Map can
not be recovered from the Map data.  

Alternatively, a Map Piece can be used in the beam line
by dragging a default identity Map from the Palette Bar
to the Model Space of the Document window.  This is
illustrated in Figure 8.  Placing a default Map Piece in this
way could be used for loading Map data from an external
file, editing map data directly, or the Map Piece could be
followed by Map Operatorand/or Analyze MapPieces to
archive a desired result.  

A default Map Piece (from the Palette Bar) represents an
identity map.  The first-order matrix is an identity matrix
and all ƒ3 and ƒ4 coefficient are zero, so there is no data
in the ƒ3 and ƒ4 tab panels of a default Map.

Create a Map of the entire
beam line for faster
tracking calculations.
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Figure 8  Dragging a Default Identity Map Piece from the Palette Bar.

The Map Piece window has a button bar and three tab
panels.  The front tab panel is for the first order matrix
data of the map.  The second and third panels are used
for non-zero ƒ3 and ƒ4 polynomial coefficients of the
map data.  These coefficient values are cataloged by an
index and a term code.  Figure 9 illustrates a Map Piece
window, showing the R-Matrix panel and the two
polynomial coefficient panels.  The ƒ3 and ƒ4 panels are
identical with the exception of an additional pop-up used
to specify ƒ4 polynomial terms.

Figure 9 illustrates the series of pop-ups that are used for
specifying a polynomial term, which is represented by a
particular term code in MARYLIE.  The pop-up choices
are {x,Px,y,Py,z,Pz and None}. These are “smart” pop-
ups that dynamically adjust themselves in series to
provide only valid choices based on previous choices
(e.g. choices for the second pop-up depend on the
selection in the first and choices for the third depend on
the second).  Only the choices that include or are below
the selection of the previous pop-up in the series are valid
choices for the next pop-up.  
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Smart Input Fields for 
Polynomial Coefficient 

Indices and Terms 

Select from Scrolling List of
Polynomial Coefficients

for Editing Individual Values

First-Order R-Matrix

Button Bar in the Map Piece Window for Displaying 
the f3 and f4 Map Coeffecients with Spectrum Plots
and for Saving and Loading External Map Data Files

Three Tab Panels in the Map Piece Window  
Provide Access to the First-Order Matrix, 

ƒ3 and ƒ4 Poloynomial Coefficients

Figure 9  Map Piece User Interface Window.

Figure 9 illustrates several features of the Map Piece user
interface including an editable display for the first-order
matrix of the map, sorted lists for non-zero ƒ3 and ƒ4
polynomial coefficients and smart input fields for
specifying polynomial terms by index or by using the
term pop-up controls.  
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Figure 10 illustrates an example for the “x2yPy”
polynomial term (index 96).  The first and second pop-ups
are set to “x”, representing x2, the third pop-up is set to
“y” so the forth pop-up can only contain {y,Py,z,Pz and
None}.  If “z” was selected then the forth pop-up would
contain {z, Pz and None}.  These pop-up selections define
the MARYLIE term code (20 11 00), which in turn has
an associated index (96), which together identify a
particular polynomial term“x2yPy”.

2 0     1 1     0 0

x   y Py2

Figure 10  Map Piece Window - ƒ4 Polynomial Terms..

Non-zero coefficients are displayed in the scrolling lists at
the bottom of the ƒ3 and ƒ4 panels.  Coefficients are
added to the list by setting the term pop-ups, the
coefficient value and pressing the “Accept” button.
Coefficients already in the list are edited by selecting from
the list and changing the coefficient value, then pressing
the “Accept” button.  Similarly the “Delete” button will
remove a selected coefficient.  Selecting from the list will
hilight the selection and automatically set the term pop-
ups and coefficient value so the user can edit or delete the
selection.  The lists of non-zero polynomial coefficients in
both the ƒ3  and ƒ4 tab panels are sorted by index.

Duplicate and non-valid
entries are not allowed in
the coefficient lists.  If an
invalid polynomial term is
specified by index or a
valid term is already in the
list, then there will be a
warring alert.
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The Map Piece also provides two buttons in the Button
Bar of the Piece window for generating Spectrum Plots
of the ƒ3 and ƒ4 polynomial coefficients.  An example is
is illustrated in Figure 11 below.  The Spectrum Plots
show the relative magnitude of coefficient values (vertical
axis) for all coefficients (horizontal axis).  The Spectrum
Plot windows support zoom-in and zoom-out features 

Valid ƒ3 polynomial coefficients range from index 1 to 83
and the range for ƒ4 is 84 to 209.  Refer to the
MARYLIE User’s Manual for a complete listing of
indices and terms.

Spectrum Plots for f3 and f4 
Polynomial Coeffecients

Figure 11  Spectrum Plots for ƒ3 and ƒ4 Coefficients.

Polynomial coefficients can
be quickly visualized with
Map Spectrum Plots.

Map Operator Piece

The Map Operator Piece provides an interface for a
variety of simple and advanced map operations that are
supported by MARYLIE.  Map operations are applied to
the transfer map at a specific locations in the beam line
during a MARYLIE execution.  The location is
established graphically by simply dragging Operator
Pieces from the Palette Bar and inserting them at the
desired locations in the beam line model.  
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Select the map operation to be performed in the
Operator Piece window (double-click the Operator Piece
after placing it in the beam line).  An Operator Piece
performs only one operation.  However several Operator
Pieces may be used sequentially or separately in the beam
line.

The Map Operator Piece window is illustrated in Figure
12 below.  The front tab panel is for Simple Operations
that replace the existing map based on the selected map
operation.  The existing map is the map calculated up to
the location of the Operator Piece in the beam line.
Simple operations require no inputs, simply select the
radio button corresponding to the desired map operation
and it will be applied at that location in the beam line
model.

Figure 12  Simple Operations Tab Panel in the Map Operator Piece Window.  

The second tab panel in the Map Piece window is for
Advanced Operations.  There are three advanced
operations that provide additional pop-up selections or
other inputs that become active when the radio button for
a particular operation is selected.  

Each Map Operations Piece can implement a Simple or
an Advanced Operation Type.  The Operation Type is
specified by the pop-up at the top of the Piece window.
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Map Analyzer Piece

TheMap AnalyzerPiece is special PBO Lab piece for the
MARYLIE Application Module.  It is similar to the
Marker Piece, because it is used to specify a variety
diagnostic outputs at specific locations in the beam line
model.  However this piece is only used by the
MARYLIE Application Module.  A Map Analyzer Piece
in the beam line model performs a single analysis task at
that location in the beam line model.  Figure 13 shows an
example of the Map Analyzer Piece window.  

Figure 13  Performing Map Analysis tasks with the Analyze Map Piece.  

The pop-up at the top of the Map Analzer window is used
to specify the particular type of map analysis to be
performed.  Input parameters for each of the analysis
tasks are provided on separate tab panels in the Piece
window.  Each of the analysis tasks supported by the
Map Analyzer Piece are described here, including twiss
analysis,  resonance analysis, normal form analysis,
invariant analysis and computing the power of the normal
form.  
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Twiss Analysis

The front tab panel of the Analyze Map Piece window
provides options for performing Twiss Analysis.  Figure
14 illustrates the Twiss Analysis tab panel.  Twiss analysis
can be performed on either the static or dynamic map,
which is selected with the radio buttons at the top of the
tab panel.  The other choices vary depending on this
option.  For static Map analysis a Momentum Spread
Variable must also be specified.  For both static and
dynamic analysis, there are three options that may be
selected.  For static analysis these are: (1) Compute Tunes
and Anharmonities, (2) Compute Twiss Parameters and
Envelopes, and (3) Compute Eigenvectors.  For dynamic
analysis these three options include Tune Expansions
(Chromaticities) for option (1), Twiss Expansions for
option (2), and Eignvector Expansions for option (3).  

Analysis results may be written to either the Marylie
Output file or the Marylie Data file.  Alternatively, output
may be directed to both files or neither file.  This option is
specified with the Output Result pop-up in the Twiss
Analysis tab panel.  Additional map data may also be
written to the Marylie Data file with the last two options
in the tab panel.  These options are based on the static or
dynamic analysis option at the top of the tab panel.  For
dynamic analysis the choices for map output include the
normalized map and the Normal Form map.  For static
analysis the choices include the closed orbit transforming
map with the normal form map and the betatron Factor
with the betatron transforming map.

Resonance Analysis

The required inputs for the Resonance Analysis task are
on a separate tab panel in the Map Analyzer Piece
window.  The options for this analysis are similar to the
Twiss analysis task.  There are radio buttons for static and
dynamic map analysis.  There are also options for
directing the output to a specific file and for writing out
map data to the Marylie Data file.

Refer to the MARYLIE
User’s Manual, Section
8.2 & 8.3

Refer to the MARYLIE
User’s Manual, Section
8.4 & 8.5
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Normal Form Analysis

The Normal Form Analysis tab panel of the Analyze
Piece includes choices for static and dynamic analysis.
There are also options for output including normal form
for exponents and the complete pseudo Hamiltonian
which can be directed to the selected output file.  In
addition there are two options for normalizing map and
normal form map data output.  

Invariant Analysis

The Invariant Analysis tab panel of the Map Analyzer
Piece has one option for regular invariant output to a
specified file and two options for writing the Normalizing
map and normal form map to the Marylie Data file.  As
with the other map analysis tasks, there are radio buttons
for selecting static or dynamic analysis.  

Power of Normal Form

The last analysis task is for computing the power of the
normal form.  The tab panel for this task contains the
required inputs including static or dynamic analysis
options, an input field for the power and selections for
both the source and target maps.

Refer to the MARYLIE
User’s Manual, Section
8.8 & 8.9

Refer to the MARYLIE
User’s Manual, Section
8.10 & 8.11

Refer to the MARYLIE
User’s Manual, Section
8.12 & 8.13
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Marker Piece

The Marker Piece is a special PBO Lab Piece that is used
to specify application-specific Constraints and Diagnostics
at specific locations in the beam line model.  A Marker
Piece window is shown in Figure 15.  

"Mark" a Location in the Beam Line for 
Specifying Marylie Fitting Constraints

Select the MARYLIE Application Context to 
Open the Fitting Constraints Window for the 

MARYLIE Application Module

Figure 15  Marker Piece Constraints and Diagnostics.

There are two scrollable lists in the Marker Piece window
that display selected Constraints and Diagnostics for any
installed Application Module.  The example shown in
Figure 15 has Constraints specified for both
TRANSPORT and MARYLIE.  A single Diagnostic is
specified for the TRANSPORT Module.  Application-
specific windows, tailored to the particular capabilities of
each Application Module, are used to specify Constraints
and Diagnostics.  The Open buttons in the Marker Piece
window are used to open the Constraint and Diagnostic
windows for the current Application Context.  The
Application Context pop-up  must be set for the
MARYLIE Application Module as illustrated in Figure
15.  

Refer to the MARYLIE
Fitting Section for a
description of the Marker
Piece and Marylie Fitting
Constraints.  
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The Open Constraints button opens the Marylie Fitting
Constraints window, which is discussed in the Fitting
Section.  The Open Diagnostics button in the Marker
Piece window opens the MARYLIE Dianostics window..
Marylie “Diagnostics” are also supported for specific
beam line locations with other Pieces, such as the Map
Operator and Map Analyzer Pieces described previously.
These pieces are tailored to the particular capabilities of
the MARYLIE program.  

Procedure Loops
Procedure Loops are a special type of subline in the beam
line topology.  In addition to the properties of Sublines,
Procedure Loops provide a means of looping through a
subline for a specified number of iterations.  The
Procedure Loop subline is only used by the MARYLIE
Application Module, and is treated as a normal Subline by
other Application Modules.  

Creating a Procedure Loop subline is similar to creating a
Subline.  However, the command for a Procedure Loop
is in the MARYLIE sub-menu of the Commands menu
and there is no Button Bar equivalent.  The MARYLIE
sub-menu in the Commands menu is only available when
the MARYLIE Application Module is installed.  After
making a selection in the beam line model, choose the
Create Procedure Loop command in the MARYLIE
Commands sub-menu.  The selection will be turned into a
Procedure Loop and you will be prompted to enter a
value for the number of loop iterations.  Once the
Procedure Loop Subline is created, the number of
iterations can be modified in the Procedure Loop Subline
window.  To remove a selected Procedure Loop, choose
the Remove Procedure Loopcommand in the MARYLIE
Commands sub-menu.  A Procedure Loop Subline can
also be removed (flattened) with the Flatten Subline
command in the Edit menu.

A Procedure Loop can be easily identified in the beam
line model by the red letter “P” in the lower left corner
of the Subline icon.  

A Procedure Loop Subline
is only used by the
MARYLIE Module, and is
treated as a normal
Subline by any other
Application Module.

T h e c o m m a n d s f o r
creating and removing
Procedure Loop Sublines
are in the MARYLIE sub-
menu of the Commands
menu, which is only avail-
able when the MARYLIE
Application Module is in-
stalled.

P

Procedure Loop Sublines
are easily identified by the
red letter “P” that
appears on the piece icon.

PBO Lab 2.0 User Manual Supplement:  MARYLIE Module

22



Marylie Options

A variety of options including calculation order and
output result, in addition to output file options and various
other preferences are specified in the Marylie Options
window.  The Options window is opened with the last
command in the MARYLIE Commands menu, as
illustrated in Figure 16 below.  Options apply to the entire
beam line model in the Model Space of the Document
window.  

The Order of Calculation and Output 
Result are Specified in the Front Tab 

Panel of the Options Window

Tab Panels for 
Additional Options

Options for the Entire Beam 
Line are Accessed from the 
Marylie Options Window

Figure 16  MARYLIE Application Module Options Window.

Calculation Order and Output Result

The order of calculation and output result are specified in
the front tab panel of the Marylie Options window, as
illustrated in Figure 16.  A pop-up is provided for
selecting between Cartesian, Static Resonance and
Dynamic Resonance basis used for Lie algebraic
generating polynomials.  
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Output File Options

The second tab panel shown in Figure 17 provides check
boxes for three output file options.  The Echo Master
Input File option is selected by default.  This option
causes the input file generated by PBO Lab to be printed
at the top of the output file.  The next option is also
selected by default.  During fitting operations, diagnostic
output will be written to the output file if the Print
Details During Fittingoption has been selected.

Figure 17  Additional Tab Panels in Options Window.

General

The first option in the General tab panel shown in Figure
17, is used to automatically recalculate an initial
distribution prior to execution of MARYLIE.  The initial
distribution will be defined by the first Beam Piece in the
beam line model.  A new distribution will be generated
each time a ray trace command is executed.  This options
is on by default.  When this option off, there must be an
existing initial distribution file in the application folder in
order to execute ray trace commands.  
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This Auto-Generate option should be off if a previously
generated distribution is to be used exclusively.  Refer to
the Beam Piece Section and the Execution Commands
Section for more information.

The next option is the Momentum Spread Variable.
There are two choices for the Momentum Spread
Variable: “Connonial Pt” and “Delta delP/P”.  There are
are also two options for Tolerance and Feeler Step Size
that are applied to all fitting procedures in a beam line
model.  

Execution Commands

The first group of commands in the MARYLIE
Commands sub-menu will automatically execute
MARYLIE after generating application-specific (native)
input from the beam line in Model Space of the
Document window.  Each of these commands results in
the Marylie Output file being automatically displayed in a
scrollable text window after execution of MARYLIE.
This file can be opened anytime using the Input File
option in the MARYLIE sub-menu in the View menu.
The Marylie Data file can also be opened in the View
menu.  Depending on selected options, the content of
these files may include the first-order matrix, non-zero
elements in the second and third-order matrices, and non-
zero coefficients in the Lie algebraic generating
polynomial. These options are described in the MARYLIE
Options Section.  Both the the input and output files are
overwritten on each execution of MARYLIE.  Use the
Save Ascommand in the File menu of the text window
to rename any I/O files if desired.

Calculate Beam Line Map
The Calculate Beam Line Map command was described
in the Running MARYLIESection.  Following the
execution of this command, a Marylie Output file will be
displayed.  The content depends on the Output Result and
other Output Options that are specified in the MARYLIE
Options window.
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Ray Trace Commands
There are two main Ray Trace commands in the
MARYLIE Commands menu.  One is for a Single Pass
ray trace and the other is for a Multi-Turn ray trace.
Each of these commands has a sub-menu with options for
Ray Traceor Element by Element Ray Trace.

The Single Passcommands are used to trace particle rays
once through the beam line model resulting in a final
particle distribution.  The initial distribution is specified
with the Beam Piece, which must be in the beam  line
model for all Ray Trace commands.  

The Multi-Turn commands trace rays through the model
for multiple “turns”.  The initial particle distribution is
passed through the beam line model, as it is for the Single
Pass command, but the resulting distribution is passed
through the beam line again and this cycle is repeated for
a specified number of turns, which yields the final particle
distribution.  The number of turns through the model is
specified with the Number of Tracking Turns Global
Parameter.

The Ray Trace commands (single pass and multi-turn)
trace particles through the beam line model using a single
transfer map for the entire beam line.  The Element by
Element Ray Trace commands calculate individual
transfer maps for each element in the beam line, resulting
in a slower but more accurate ray trace.  

Write and View Commands
The second group of commands are used to generate
native input without automatically executing MARYLIE,
allowing the input generated by PBO Lab to be edited
prior to running MARYLIE.  This provides total access to
the native execution of the program for expert users that
are experienced with the format and syntax of the various
Marylie input files.  The command Write Input File and
View generates a MARYLIE master input file named
“Marylie Input” from the beam line model.  This file is
opened in an editable text window, but MARYLIE is not
executed.

PBO Lab 2.0 User Manual Supplement:  MARYLIE Module

26



Modifications may be made to the input file and saved
using the Savecommand in the File menu of the text
window.  This file can be used as input to MARYLIE
with the Run ‘Marylie Input’command.  This command
is used to execute MARYLIE without generating new
input.  Any changes made to the Marylie Input file will
not be overwritten with model data.  The existing input
files in the application folder will be used to execute
MARYLIE.  

Write Fitting Files and View is another write-and-view
command that is used to generate the input files that
define fitting variables, constraints and procedures for
MARYLIE.  This command does not execute the
MARYLIE program.  The fitting files are generated from
settings in beam line model and can be displayed in
editable text windows.  These files are used when
MARYLIE  is  executed  with  the  Run ‘Marylie Input’
command.  The existing master input file will be over
written when the fitting files are generated.  The Marylie
Input file must include the appropriate commands to
instruct MARYLIE to perform the operations specified
by the fitting files.  The input file is automatically opened
in an editable text window.  The File menu of the text
window can be used to Openany of the fitting input files.
Refer to the MARYLIE Fitting Section for additional
information.  

MARYLIE View Menu Commands

The MARYLIE Master Input File (MIF) is generated by
PBO Lab from the beam line model in the Document
window.  This file is entitled “Marylie Input”.  This file
can be displayed and edited at any time with the Input
item in the MARYLIE sub-menu of the View menu in
the Document window.  Similarly the Marylie Output and
Marylie Data file can be opened and displayed in an
editable text window with commands in the View menu.
The raw data files for both initial and final particle
distributions can also be opened with View menu
commands.  

MARYLIE View Sub-menu.
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MARYLIE Distribution Plots

Three commands in the MARYLIE Commands menu
(Figure 18) are used to generate and plot distribution
data.  The Generate Distribution command is used to
create an initial particle distribution.  The Marylie Input
and Emittance files are generated from the beam line
Beam Piece and Global Parameters.  MARYLIE creates a
new Distribution file, but the standard output file in not
opened  
following execution.  The Plot Initial Distribution
command can be used to open a Plot Specification
window for initial distribution data.  This command can
be used any time there is an existing Distribution file in
the application folder.  Refer to the Beam Piece sub-
section for a description of particle distributions.  

The Plot Final Distribution command is used to open
the Plot Specification window for the final distribution
data generated by MARYLIE with a Ray Trace
command.  Figure 18 shows the Plots Specification
window and several Marylie Plot windows.

The Generate Distribution
command is equivalent to
using the Generate Distri-
bution button in the Beam
Piece window.

Figure 18  Final Distribution Plots.

PBO Lab 2.0 User Manual Supplement:  MARYLIE Module

28



3. MARYLIE Fitting
The MARYLIE program can be used to find solutions
for a variety of beam line design problems.  Problems are
formulated in terms of user-specified variables and
constraints.  Beam line parameters are varied in an
attempt to satisfy (“fit”) constraints within a specified
tolerence.  A Procedure loop is used to specify the scope
of a fitting operation.  Procedure Loops provide a means
of looping through a subline for a specified number of
iterations.  After specifing fitting variables, constraints and
procedure loops in the beam line model the Perform
Fitting command in the Marylie Commands menu is used
to execute the fitting procedures.  MARYLIE will attempt
fitting for each procedure loop until the constraints have
been fit within tolerence or the maximum number of
iterations has been reached in the procedure loop.  When
the fitting procedures are completed the resulting values
for fitting variables are shown in the Update Fitting and
Coupling Parameters window.  The new parameter values
may then be used to update the beam line model.

Specifing Variable Parameters
A Variable Parameter is specified in the Special Parameter
Settings window, which is opened by pressing the Special
(“S”) button to the left of the parameter in the Piece
Window.  Figure 19 illustrates selecting a Quadrupole
Magnetic-Field Gradient parameter as a fitting variable;
pressing the “S” button for this parameter opens the
Special Parameter Settings window.  

Most Piece Parameters have "S" 
(Special) Buttons that open Special 

Parameter Settings Windows

Figure 19  Special Parameter Settings Window. 

Refer to the Procedure
Loops Section in this
Chapter.

All variable parameter
selections are saved with
the beam line model when
using a Save, or Save As,
command.
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Special Parameter Settings Window

The Special Parameter Settings window is used for
specifying application-specific options.  The “S-Windows”
have Application tab panels that provide access to
application-specific options for all installed Application
Modules.  Special parameter settings are retained when
the model is saved with the Save or Save As command.  

The MARYLIE Application Module supports specifing a
parameter as a fitting variable, coupling variable or import
variable.  Figure 20 shows the Marylie tab panel for a
Quadrupole Magnetic-Field Gradient parameter.  

Special Parameter Settings are in 
Application-Specific Tab Panels

Figure 20  Special Parameter Settings for the Marylie Module.

The top panel of the S-window displays the Piece
comment and the selected parameter name.  There is an
input field for a Parameter Variable name.  When
required, a default name will be generated if a name has
not been entered in the Parameter Variable field at the top
of the S-window.  The same Parameter Variable name is
used for all installed Application Modules.

The bottom half of the window will contain tab panels for
the different application modules.  When the Marylie
Application Module is installed there will be a Marylie tab
panel in the Special Parameter Settings window if that
parameter is a native MARYLIE input and it is supported
as a variable parameter by the MARYLIE program.
Otherwise there will not be a tab panel for Marylie.
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The first radio button in the Marylie tab panel is the
default selection.  It indicates that the parameter is defined
by the numerical value entered in the piece window, i.e.
there are no special settings for this parameter.  The
second radio-button selects the parameter as a variable
parameter and the third radio-button selects it as a
coupling variable.  If the parameter is selected as a
coupling variable then the pop-up to the right becomes
active.  This pop-up contains a list of all the specified
fitting variables in the beam line model.  The parameter
may be coupled to any fitting variable by choosing it
from this pop-up list.  There is also an input field for the
Coupling K Factor used for coupling variables.

Fitting Variables Window

PBO Lab provides windows that list all of the fitting
variables and coupling variables for the entire beam line
model.  These windows can be used to quickly access the
piece windows for elements with fitting variables or
coupling parameters.  Figure 21 illustrates opening the
Fitting Variables window from the MARYLIE
Commands menu.  The header at the top of these
windows can be used to adjust the width of each column
in the window.  To resize a column place the mouse over
the divider line in the column header.  When the arrow
turns into a cross-hair the column can be resized by
holding the mouse button down while draging
horizontally.

Couple Variables Window

The Couple Variables windows lists all of the parameters
that are coupled to fitting variables in the entire beam line
model.  As with the Fitting Variables window, double-
clicking an entry in this window allows you to quickly
access the piece windows for that parameter.  Figure 21
shows the Couple Variables command in the MARYLIE
Commands menu.
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The Fitting Variables command in
the MARYLIE Commands menu

opens the Fitting Variables window
 that contains all the Marylie fitting 
variables for the beam line model

Double-clicking an entry in the Variable 
Parameters window will open the associated 

Piece window for that parameter variable

The Couple Variables command 
opens the Couple Variables window

Figure 21  Example of the Marylie Fitting Variables Window.

Fitting Constraints

Fitting constraints are specified at specific locations in the
beam line using a Marker Piece.  Drag a Marker Piece
from the Palette Bar and insert it at the desired location in
the beam line model.  This may or may not be the end of
the beam line. Open the Marker window by double
clicking the Piece icon as illustrated in Figure 22.  

A Marker Piece is used to define application-specific
constraints and diagnostics that are dependent on a
specific location in the beam line model.  A Marker Piece
can be used by all installed Application Modules and is
therefore dependent on the Application Context switch
setting in the Document window.  The Marker Piece
window has two panels.  Each panel displays a list of the
currently selected Constraints and Diagnostics for all
Application Modules.  

For a general description
of the Marker Piece refer
to the Marker Piece
Section.

The Open buttons in the
Marker Piece window use
the Application Context
switch in the Document
window to open the
appropreate application-
specific user interface
window.  
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Open the Marylie Fitting 
Constraints Window

The Application Context Switch must be 
set for the MARYLIE Application Module

Figure 22  Fitting Constraints and the Marker Piece window.

The Marker Piece window shown in Figure 22 has fitting
constraints for both the TRANSPORT and MARYLIE
Application Modules, as well as diagnostics for the
TRANSPORT and TURTLE Modules.  Each entry is
preceeded by the application name.  Making a selection in
these lists and pressing the Remove button will delete that
entry from the list.  Pressing the Open button in the
Constraints panel will open the Fitting Constraints
window for the currently selected Application in the
Application Context switch.  To open the Marylie Fitting
Constraints window the Application Context switch must
be set for the MARYLIE Application Module.  Similarly,
the Open button in the Diagnostics panel will open the
application-specific user interface window for the current
Application Context.  However, not all of the Application
Modules have location specific Constraint and/or
Diagnostic options,.in which case no window will be
opened.  

The Marker Piece can be
used to define application-
specific constraints and
diagnostics at specific
beam line locations.  

The Final Piece has the
same functionality as the
Marker Piece for the
Marylie Module.  
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Fitting Constraints Window

A Marylie Fitting Constraints window can be opened by
double-clicking any Marker or Final Piece in the beam
line model.  The Open button in the Constraints panel of
the Marker Piece window opens the Fitting Constraints
window.  However, the Application Context popup at the
top of the Piece window must be set to MARYLIE.
Figure 23 below illustrates the primary features of the
Marylie Fitting Constrants window.  A variety of
program variables can be selected as Constraint
Expressions.  The Fitting Constraints window groups
fitting constraints into seven catagories: Lattice Functions,
Lattice Properties, Anharmonic Lattice Parameters,
Emittances, Lie Polynomial Coefficients, Beam Matrix
elements (reduced sigma matrix) and elements of the first-
order transfer matrix (R-Matrix).  

T h e T o l e r a n c e v a l u e
shown at the top of the
window is used for all
constraints.  This value is
specified in the Marylie
Options window.  Refer to
Marylie Options Section.

The "Add to Expression" Button will add 
the Selection to the Constraint Expression 
( the MARYLIE Key Word will be put in the 
Constraint Expression Field)

The "Accept Expression"  Button accepts 
the Constraint Expression  and Value and 
adds it to the Constraint Experession List

Lattice Functions,
Lattice Properties,
Anharmonic Lattice Properties,
Emittances,
Lie Polynomial Coefficients,
Beam Matrix Elements, and
R Matrix Elements

Use Radio Buttons to Select from 
the Seven Different Catagories of 
Constraints:

Make a Choice in the 
Selected Catagory

Enter a Constraint Expression 
(MARYLIE Key Word) and a Fit 
Value or Make a Selection from 
the Choices below 

The "Delete Expression" Button  will 
Remove a Selected Constraint from the 
Constraint Expression List

Figure 23  Marylie Fitting Constraints Window.
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Table 1 lists the different selections in each catagory for
fitting constraints.  

Table 1.  Pop-up Fitting Constraints

Lattice Functions Keyword
Accelerator Function AlphaX ax
Accelerator Function BetaX bx
Accelerator Function GammaX gx
Accelerator Function AlphaY ay
Accelerator Function BetaY by
Accelerator Function GammaY gy
Accelerator Function AlphaZ at
Accelerator Function BetaZ bt
Accelerator Function GammaZ gt
Accelerator Function EtaX dz1
Accelerator Function DeltaX dz2
Accelerator Function EtaY dz3
Accelerator Function DeltaY dz4

Emittances Keyword
Horizontal (X) rms Emittance ex
Vertical (Y) rms Emittance ey
Longitudinal (Z) rms Emit. et

Lattice Properties Keyword
Horizontal (X) Tune tx
Vertical (Y) Tune ty
Synchrotron Longitudinal (Z) Tune ts
Horizontal (X) First Order Chrom. cx
Vertical (Y) First Order Chromaticity cy
Horizontal (X) Second Order Chrom. qx
Vertical (Y) Second Order Chrom. qy

Anharmonic Parameters Keyword
Horz.(NuX) Tune, dependence on X hh
Vertical (NuY) Tune,depend. on Y vv
Long. (NuZ) Tune, dependence on Z tt
Horz. (NuX) Tune, dependence on Y hv
Vertical (NuY) Tune, depend. on X hv
Horz. (NuX) Tune dependence on Z ht
Long. (NuZ) Tune, dependence on X ht
Vertical Tune (NuY) depend. on Z vt
Long. (NuZ) Tune, dependence on Y vt

Beam Matrix Keyword
Sigma (σ) Matrix Element S(i,j)

R-Matrix Keyword
1st Order Transfer Matrix Element R(i,j)

Lie Polynomial Coefficients Keyword
Individual Polynomial Coefficients F(k)

The Constraint Expression field at the top of the Fitting
Constraints window can be used to directly enter
MARYLIE keywords.  After assigning a fit Value, the
Accept Expression button is used to add the constraint to
the list at the bottom of the window.  

You don’t need to know the keyword to specify a
constraint.  Simply chose a constraint catagory by
selecting one of the seven radio buttons, then pick a
constraint from the various selections in that catagory and
press the Add to Expression button.  The MARYLIE
keyword will be automatically entered into the Constraint
Expression field.  After assigning a fit Value, use the
Accept Expression button to add the constraint to the list
at the bottom of the window.  
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The Constraint Expression list at the bottom of the
window lists all of the fitting constraints defined for this
Marker location in the beam line model.  To select an
existing constraint click on the entry in the Constraint
Expression list.  The selection will be hi-lited in the list and
the edit fields at the top of the window will be updated
with the selection.  To edit an existing constraint, select it
from the list, make any changes and press the Accept
Expression button; the selected constraint will be updated
with the changes.  The Delete Expression button is used
to remove an existing constraint.  Select the constraint in
the Constraint Expression list and press the Delete
Expression button.  A constraint can also be deleted
directly from the Marker Piece window without opening
the Fitting Constraints window.  Select the constraint in
the Constraints list in the Marker (or Final) Piece window
and then press the Remove button.

Constraint Expressions List Window
Multiple Marker Pieces in the beam line model can be
used to specify fitting constraints at different locations in
the beam line.  However, all of the constraints defined for
the entire beam line model are listed together in the
Constraint Expressions List window shown in Figure 24.  

The Constraint Expression
List window provides
quick access to fitting
constraints over the entire
beam line.  Simply double
click an entry in the list to
open the associated Mar-
ker Piece Window.

Figure 24  Marylie Fitting Constraint Expressions List Window.
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Fitting Procedure Loops

The final step required for a MARYLIE fitting problem is
to specify a fitting Procedure Loop.  Procedure Loops are
a special type of subline that is created for a selection of
Pieces in the beam line model.  The Procedure Loop
Section provides a general description the Procedure
Loop.  The Procedure Loop Subline is only used by the
MARYLIE Application Module, and is treated as regular
Subline by other Application Modules.

Procedure Loop sublines are used to define the scope of a
fitting problem, i.e. the segment of the beam line that will
be looped over durring the fitting operation.  The
maximum number of fitting iterations is also specified
with the Procedure loop.  A Procedure Loop subline is
created in the beam line model like a normal Subline, by
selecting a segment of the beam line and chosing the
Create Procedure Loop command in the MARYLIE
Commands menu.  The Procedure Loop subline must
include at least one Marker or Final Piece that specifies
one or more fitting constraints.  It must also include
Pieces with specified fitting variables.  A Procedure Loop
may include the entire beam line model or a particular
segment of the beam line.  The Select All command
followed by the Create Procedure Loopcommand will
make a Procedure Loop for the entire beam line model.
Selections within the beam line model can be made by
holding down the mouse button while dragging a box
around the desired Pieces in the model space.  The
control key can be used to make a larger selection from a
series of selections.  For example, if the beam line model
needs to be scrolled to select more pieces than are visible
in the model space; make the first selection and then hold
down the control key while making another selection with
the mouse.  Larger models can also be organized with
nested Sublines, which may also be included in Procedure
Loops just like any other beam line element.

T h e P r o c e d u r e L o o p
Subline is a MARYLIE
object.  It is treated as a
normal Subline by all
other Application Modules.

T h e c o m m a n d s f o r
creating and removing
Procedure Loop Sublines
are in the MARYLIE sub-
menu of the Commands
menu, which is only avail-
able when the MARYLIE
Application Module is in-
stalled.

P

Procedure Loop Sublines
are readily identified by the
red “P” that appears on
the piece icon.
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To remove a Procedure Loop (flatten a selected
Procudere Loop subline), choose the Remove Procedure
Loop command in the MARYLIE Commandsmenu or
the Flatten Sublinecommand in the Edit menu.  The
Flatten Subline button in the Button Bar will also flatten a
Procedure Loop.

Perform Fitting
The Perform Fitting command in the MARYLIE
Commands menu (Figure 25) is used to execute any
fitting procedures specified in the beam line model.  Once
fitting variables and constraints have been defined and
Procedure Loops have been created, the Perform Fitting
command will generate the required input files and
execute MARYLIE.  

Figure 25  Execute MARYLIE Fitting with the Perform Fitting Command.

Update Parameter Variables
After MARYLIE has completed a fitting task, the new
values for parameter variables can be used to update the
model.  The Update Parameter Variables Window,
,opened automatically following a fitting procedure, is
used to examine the new values for each of the parameter
variables and update the beam line model.

After a fitting operation the
fitted parameter variables
are displayed in an Update
window.  However, the
beam line model is not
changed until the fit values
are explicitly accepted in
the Update window.  
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The Update Parameter Variables Window contains two
scrolling list for variable and coupling parameters.  The
list at the top of the window displays all of the user
specified Marylie fitting variables (variable parameters) for
the entire beam line.   The list at the bottom contains  any
user specified parameters that are coupled to specific
fitting variable parameters.  Both the variable and
coupling parameter lists have buttons for updating the
beam line model with the new fitted parameter values.

The Update All Values button can be used to update all of
the variable parameters in one step.  Alternatively the
Update Selected Value button can be used to update
variable parameters individually.  (There are identical
buttons for the Coupling Parameters in the lower half of
the window.)  To update parameters individually make a
selection in the list of parameters and press the Update
Selected Value button.  When a selection is made in the
list it will be hilited as shown in Figure 26.  Using the
mouse to double-click a list entry will open the Piece
window for that parameter.  

Double-click a variable or
coupling entry to open the
Piece window for that
parameter.

Scrolling List of 
User Specified 

Variable Parameters

Scrolling List of 
User Specified 

Coupling Parameters
Double Click an Entry to Open the 
Piece Window for that Parameter

Click on an Entry to Select it in the List. 

Update Only Selected 
Variable Parameters

Update All Variable 
Parameters in the List

Parameter Values 
Before and After Fitting

Column Widths can be Adjusted with 
the Mouse in the Header of Each List

Figure 26  Update Parameter Variables Window.  
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The Update Parameter Variables window can be left open
and the beam line will not be updated with the new fit
values until one of the Update buttons is used.  However,
if the window is closed prior to updating the beam line,
then the fitting results are disposed and the beam line
model is unchanged.  

MARYLIE Type-Code Mnemonics

A cross reference of all MARYLIE type-code mnemonics
to their corresponding PBO Lab graphic interface
components is provided in Table 2.  The MARYLIE type-
code mnemonics are those listed in Section 13.1 of the
MARYLIE 3.0 User’s Manual.  Table 2 repeats from that
Section the brief summary of each type code’s purpose
and the MARYLIE 3.0 User’s Manual subsection
reference. The corresponding PBO Lab component is
given in the right-most column.

Comments under the PBO Lab Component column in
parentheses indicate items that have no corresponding
interface component.  Some of the MARYLIE type codes
are not relevant “(Not used in PBO Lab)”.  Other type
codes are created automatically by the PBO Lab
“ (Automatically done)”.  In addition, certain type codes have
yet not been implemented in MARYLIE “(Not yet in
MARYLIE) ”, or require the Profession version of PBO
Lab in order to customize the MARYLIE Module
“ (Requires user-written code)”.  MARYLIE type-code
mnemonics where the corresponding PBO Lab
Component is indicated as “---” do not have an interface
component in the current beta version of PBO Lab 2.0,
but will be implemented in a future release.  Finally, a few
type codes do not yet have a strict one-to-one
correspondence with any PBO Lab Component, but are
utilized by certain PBO Lab ‘macro commands’; the
PBO Lab Components which create these macro
commands are indicated in parenthesis “(Beam Piece)”. 

Software updates occur
more frequently than user
manual update, and new
capabilities are being
added to the MARYLIE
Module.  Contact AccelSoft
(accelsoft@ghga.com) if
there is a question con-
cerning any particular
feature.
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Table 2.  Cross reference of MARYLIE type-code mnemonics, listed
alphabetically, to PBO Lab interface components. 

                                                                                                                                                         

Type Code Purpose MARYLIE Subsection PBO Lab Component
                                                                                                                                                         

aim Specify quantities to be fit or 9.5 Marker Piece
optimized and set target values.  

amap Apply map to a function or moments. 8.17  ---
arc Arc for accounting purposes. 6.31  (Not yet in MARYLIE)
arot Axial rotation. 6.14  Rotate Piece
asni Apply script N inverse. 8.29  ---
bell Ring bell at terminal. 7.31  (Not used in PBO Lab)
bgen Generate beam. 8.34  Beam Piece
bip Begin inner procedure. 9.1  Create Procedure Loop
bop Begin outer procedure. 9.2  Create Procedure Loop
cbm Change or write out beam parameters. 7.39  (Not used in PBO Lab)
cdf Change drop file. 7.30  (Not used in PBO Lab)
cf Close files. 7.23  (Automatically done)
cfbd Combined function bend. 6.8  Bend, S-Bend Pieces
cfqd Combined function magnetic quadrupole.6.24  ---
cfrn Change or write out values of fringe field6.29 Bend, S-Bend Pieces

parameters for combined function dipole.  
circ Set parameters and circulate. 7.3 Commands Menu
cod Compute off-momentum closed orbit data.8.1 ---
conl Constraints. 9.12  (Requires user-written code)
con5

: 

cplm "Compressed" approximation to low 6.17 ---
order multipoles. 

cpsl Capture parameter set. 9.15  ---
:

cps9 
csym Check symplectic condition. 8.31 ---
ctr Change tune range. 8.28 ---
dapt Compute dynamic aperture. 9.19 ---
dia Dynamic invariant analysis. 8.11 Map Analyzer Piece
dims Dimensions. 7.40 (Not yet in MARYLIE)
dism Dispersion matrix. 6.22 Eta Piece
dnor Dynamic normal form analysis. 8.9 Map Analyzer Piece
dp Data point. 6.26 ---
dpol Dispersion polynomial. 7.38 ---
drft Drift space. 6.1 Drift Piece
eapt Aperture the beam with an elliptic aperture.7.19 ---
end Halt execution. Must be an 7.1 (Automatically done)

entry of a #labor list. 
exp Compute exponential. 8.7 Map Operator Piece
fadm Fourier analyze dynamic map. 8.16 (Not yet in MARYLIE)
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Table 2. Cross reference of MARYLIE type-code mnemonics (continued).

                                                                                                                                                         

Type Code Purpose MARYLIE Subsection PBO Lab Component
                                                                                                                                                         

fasm Fourier analyze static map. 8.15 (Not yet in MARYLIE)
fit Carry out fitting operation. 9.7 Procedure Loop
flag Change or write out values of 9.17 (Not used in PBO Lab)

flags and defaults. 
fps Free parameter set. 9.16 (Not yet in MARYLIE)
frng Used for hard-edge dipole 6.7 Bend, S-Bend Pieces

fringe fields. 
ftm Filter the existing transfer map. 7.22 ---
fwa Copy file to working array 8.39 (Not used in PBO Lab)
gbdy Used for the body of a general 6.6 Bend, S-Bend Pieces

bending magnet. 
gbnd General bending magnet. 6.4 Bend,S-Bend, R-Bend Pieces
gbuf Get buffer contents. 8.14 Map Operator Piece
geom Compute geometry of a loop. 8.38 Floor Coords., Lattice Plots
grad Compute gradient matrix. 9.13 ---
gtm Get a transfer map from storage. 7.17 Map Operator Piece
iden Replace existing transfer map by the 7.8 Map Operator Piece

identity map. 
inf Change or write out values of infinities. 7.35 (Not used in PBO Lab)
lnv Replace existing transfer map by its inverse 7.9 Map Operator Piece
jmap Map with matrix part J. 6.18 ---
mark, Marker. 6.25 Marker, Final Pieces
mask Mask off selected portions of existing 7.13 Options-Calculation Order

transfer map. 
mn Compute matrix norm. 8.33 Map Math Piece
moma Moment analysis. 8.37 ---
mrto Merit function (sum of squares). 9.10 ---
mrtl Merit functions (user written). 9.11  (Requires user-written code)

:

mrt5 
mss Minimize sum of squares optimization. 9.8 ---
nbnd Normal entry bending magnet, 6.2 Bend, S-Bend Pieces

with or without fringe fields. 
num Number lines in a file. 7.27 (Not used in PBO Lab)
octe Electric octupole. 6.12 ---
octm Magnetic octupole. 6.11 Octupole Piece
of Open files. 7.24 (Automatically done)
opt General optimization. 9.9 ---
padd Add two polynomials. 8.19 Map Math Piece
paws Pause. 7.34 (Not used in PBO Lab)
pb Poisson bracket two polynomials. 8.21 Map Math Piece
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Table 2. Cross reference of MARYLIE type-code mnemonics (continued).

                                                                                                                                                         

Type Code Purpose MARYLIE Subsection PBO Lab Component
                                                                                                                                                         

pbnd Parallel faced bending magnet, 6.3 R-Bend Piece
with fringe fields and equal 
entry and exit angles. 

pdnf Compute power of dynamic normal form.8.13 Map Analyzer Piece
pmif Print contents of Master Input File (file 11) 7.4 Options - Echo MIF
pmul Multiply two polynomials. 8.20 Map Math Piece
pnlp Compute power of nonlinear part. 8.30 Map Math Piece
pold Polar decomposition of a map. 8.22 Map Math Piece
ppa Principal planes analysis. 8.36  (Not yet in MARYLIE)
prot Used for leading and trailing 6.5 Bend, S-Bend Pieces

pole face rotations. 
ps1 Parameter set specification. 7.25  Param Piece

:

ps9 
psnf Compute power of static normal form. 8.12  Map Analyzer Piece
psp Polynomial scalar product. 8.32 Map Math Piece
ptm Print transfer map. 7.7 Marker Piece & Options
pval Evaluate a polynomial. 8.23 ---
quad Magnetic quadrupole. 6.9 Quad Piece
radm Resonance analyze dynamic map. 8.5 Map Analyzer Piece
rapt Aperture the beam with a rectangular 7.18 Aperture Piece

aperture.
rasm Resonance analyze static map. 8.4 Map Analyzer Piece
recm REC quadrupole multiplet. 6.27 ---
rev Replace existing transfer map by 7.11 Map Operator Piece

its reversed map. 
revf Replace existing transfer map by 7.12 Map Operator Piece

reverse factorized form. 
rmap Random map. 6.30 ---
rpsl Random parameter set specification. 7.26  ---

:

rps9 
rset Reset menu entries. 9.18 (Not used in PBO Lab)
rt Perform a ray trace. 7.2 Commands Menu
r**** Random counterpart of the element 6.19 ---

with type-code mnemonic****.
scan Scan parameter space. 9.14  ---
sext Magnetic sextupole. 6.10  Sextupole Piece
sia Static invariant analysis. 8.10  Map Analyzer Piece
smul Multiply a polynomial by a scalar. 8.18  Map Math Piece
snor Static normal form analysis. 8.8  Map Analyzer Piece
sol Solenoid. 6.23  Solenoid Piece
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Table 2. Cross reference of MARYLIE type-code mnemonics (continued).

                                                                                                                                                         

Type Code Purpose MARYLIE Subsection PBO Lab Component
                                                                                                                                                         

spce Space for accounting purposes. 6.28  ---
sq Select quantities. 8.26  Fitting Constrants
sqr Square the existing transfer map. 7.15  Map Operator Piece
srfc Short RF cavity. 6.13  RF Gap Piece
stm Store the existing transfer map. 7.16  Map Operator Piece
symp Symplectify matrix portion of transfer map. 7.14  Map Operator Piece
tadm Twiss analyze dynamic map. 8.3  Map Analyzer Piece
tasm Twiss analyze static map. 8.2  Map Analyzer Piece
tbas Translate basis. 8.6  Map Operator Piece
thlm "Thin lens" approximation to low 6.16 ---

order multipoles.  
tic Translate initial conditions. 8.35  Centroid Piece
time Write out execution time. 7.29  (Not used in PBO Lab)
tip Terminate inner procedure. 9.3  Create Procedure Loop
tmi Input matrix elements and polynomial 7.5 Map Piece

coefficients from an external file.  
tmo Ouptut matrix elements and polynomial 7.6 Map Piece

coefficients to an external file.  
top Terminate outer procedure. 9.4  Create Procedure Loop
tpol Twiss polynomial. 7.37  Beam Piece
tran Replace existing transfer map by its 7.10 Map Operator Piece

"transpose".
trda Transport dynamic A. 8.25  (Not yet in MARYLIE)
trsa Transport static A. 8.24  (Not yet in MARYLIE)
twsm Linear matrix transformation specified 6.15 (Beam Piece)

in terms of twiss parameters. 
usrl User specified subroutines that 6.20 (Requires user-written code)

act on phase space data. 
:

usr10 
usr11 User specified subroutines that 6.21 (Requires user-written code)

produce or act on maps. 
:

usr20 
vary Specify quantities to be varied. 9.6 S-Window on Pieces
wcl Write contents of a loop. 7.33 ---
whst Write history of beam loss. 7.21 ---
wmrt Write out value of merit function. 7.32 ---
wnd Window a beam. 7.20 Aperture Piece
wps Write out parameters in a parameter set.7.28 ---
wsq Write selected quantities. 8.27 (Create Procedure Loop)
wuca Write out contents of ucalc array. 7.41 ---
zer Change or write out values of zeroes. 7.36 (Not used in PBO Lab)
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